Executive Summary

During November 2002, eleven participants completed a usability test session of version 1.0 of the Variations2: IU Digital Music Library software. Variations2 aims to establish a digital music library testbed system containing music in a variety of formats. The current Variations system is used primarily by music students to listen to CD-quality recordings online at computer workstations in the IU-Bloomington Cook Music Library.

Results indicated average to above-average satisfaction ratings with the system as a whole. Users enjoyed the searching process and had no great difficulties using the media player. Although there was a learning curve exhibited, most users appreciated the functionality that the system provided once they understood how to perform tasks such as bookmarking and exporting to Web pages. Users who looked at the Help Page were generally able to find the necessary information and subsequent task success.

Major problems were associated with tasks which required participants to print score or translation pages. The icon for both a translation and a score is identical. This caused some users to accidentally open a score rather than a translation or vice versa. Once inside the score/translation viewer the term “Export to browser…” was not understood as the path to take to print something. As well, the use of the external .djvu viewer presented several difficulties due to multiple print options, downloading of large numbers of files, and large drop-down lists of selectable page numbers with no outline or “jumping” capability.

Recommendations for redesign based on all user sessions are provided. These include suggestions for major system improvement such as synchronization of the score movement and recording playback (especially with regard to placing bookmarks for .html page creation), improvement of the printing process, expansion to the help page, and bookmarking design ideas. Other less crucial recommendations are also noted, such as rewording of button texts and interface changes to the media player.
# Table of Contents

I. Purpose of the Study .................................................1
II. Participants..................................................................6
III. Method.......................................................................7
IV. Findings .......................................................................8

**Scenario 1**..................................................................8
Searching ..........................................................................8
Media Player & Track Times .................................................9
Score Viewer.......................................................................9
Icons .................................................................................9
Export to Browser Command .............................................10
Page Number Synchronization ..........................................11
Help Page Window .........................................................12
Multiple Print Options ....................................................13
Miscellaneous Print Problems ..........................................13
Downloading Files .........................................................14

**Scenario 2**..................................................................15
Help Page ..........................................................................15
Bookmarking .................................................................16
Synchronization ...............................................................16
Exporting ..........................................................................17
File Structure Navigation ...............................................18

**Satisfaction Ratings**.....................................................19

V. Recommendations .....................................................22
VI. Discussion ....................................................................25

VII. Appendices:

Demographic Questionnaire .............................................27
Scenarios .........................................................................28
Satisfaction Survey .......................................................30
I. Purpose of the Study

The Variations2: IU Digital Music Library project (V2) aims to establish a digital music library testbed system containing music in a variety of formats. The current Variations system is used primarily by music students to listen to CD-quality recordings online at computer workstations in the IU Cook Music Library.

This formative usability test examined Variations2 version 1.0 which was released in fall 2002. Goals of this test included several goals first examined in a usability test (conducted summer 2002) of a Variations2 prototype:

- Determine what problems users have when searching for selections;
- Determine what problems users have when accessing listening selections with the media player;
- Observe which methods of score viewing users prefer;
- Determine what problems users have when accessing scores;
- Determine which media player/score viewer components are used/ignored when listening to a selection;
- Test for ease of navigation amongst different player windows;
- Identify bookmarking functionality problems;
- Determine whether current help page contains appropriate and easily accessible help topics;
- Monitor problem areas to determine which need to be added to the help page;
- Gauge users’ levels of frustration and/or satisfaction with V2.

For the current usability test, additional areas of interest included investigations into user actions associated with tasks such as searching for, viewing and printing scores/translations, and using the bookmarking features to dynamically create .html Webpages. These tasks required interaction with features that were either newly implemented in Variations2 version 1.0 or redesigned based on recommendations made as a result of the test performed on the Variations2 prototype in summer 2002.

Variations2 Components

Test tasks were embedded within two scenarios. Each scenario was intended to elicit user manipulation of particular Variations2 components and features as detailed in the two sections below.

Scenario 1

Scenario 1 required users to search for specific Schubert songs using the Search Window (Figure 1), then record the track times for the retrieved pieces from the media player (Figure 2). As well, users were asked to print a score and a translation/text for two pieces via the Score Viewer (Figure 3) and .djvu viewer interface (Figure 4).
Fill in as many of the query fields above as you wish, then click Search.

Figure 1 - Search Window

Figure 2 - Media Player
Figure 3 - Score/Translation Viewer
Scenario 2

Scenario 2 tasks required students to use Variations2 to complete a class assignment by making a webpage using the bookmarking features (Figure 5). The assignment was presented to users as an online webpage (Figure 6). At the top of the assignment webpage, users are encouraged to check the Variations online help page (http://variations2.indiana.edu/help/) for help. The help page is currently a single webpage divided into major sections in Q & A format (see Figure 7). It is available from any V2 window by clicking the Help menu and selecting the “Variations2 Help Page” option.
**Figure 5 - Bookmark Editing Window**

**Figure 6 - Scenario 2 Assignment Webpage**
II. Participants

Eleven music students were recruited by the facilitator from two fall 2002 semester classes (M401 and a graduate seminar) at the IU School of Music. During recruitment, the facilitator explained the purpose of the study and passed around a sign-up sheet which was identical for both classes. Those students who were interested in participating wrote their names and email addresses on the sheet. The facilitator then contacted them at a later time to set up session times. The first student session was completed as a Pilot test and the data not used in subsequent analysis. Thus, the remaining discussions of data are inclusive only of the last ten participants.

As illustrated in Table 1 below, participants had varying majors, ages, general computer experience, prior Variations experience and reasons for using Variations. All were music majors and there were a variety of majors represented, including, e.g., musicology, piano, and bassoon. Their ages ranged from 19 – 25 years, with a mean age of 21.3 years. All participants listed their native language as English.

Six participants claimed to use computers at least 11 hours a week, with the other four using 6-10 hours per week. Platform experience ratings reflected moderate to high experience with PC’s and moderate to low experience with Mac’s. On a scale from 1-5, with 1 being Novice and 5 being Expert, the mean result for PC use was 3.45 and for Mac use was 2.4.
Table 1: Participant Characteristics

<table>
<thead>
<tr>
<th>#</th>
<th>Gender</th>
<th>Age</th>
<th>Major</th>
<th>Computer Use (hrs/wk)</th>
<th>Computer Experience (1=novice - 5=expert)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>M</td>
<td>20</td>
<td>Piano</td>
<td>6-10</td>
<td>4</td>
</tr>
<tr>
<td>2</td>
<td>M</td>
<td>21</td>
<td>Clarinet; Audio Recording</td>
<td>11-20</td>
<td>4</td>
</tr>
<tr>
<td>3</td>
<td>M</td>
<td>25</td>
<td>Musicology</td>
<td>11-20</td>
<td>4</td>
</tr>
<tr>
<td>4</td>
<td>F</td>
<td>22</td>
<td>Bassoon</td>
<td>11-20</td>
<td>3.5</td>
</tr>
<tr>
<td>5</td>
<td>F</td>
<td>22</td>
<td>Musicology</td>
<td>20+</td>
<td>3</td>
</tr>
<tr>
<td>6</td>
<td>F</td>
<td>20</td>
<td>Oboe</td>
<td>6-10</td>
<td>3</td>
</tr>
<tr>
<td>7</td>
<td>F</td>
<td>19</td>
<td>Violin</td>
<td>6-10</td>
<td>3</td>
</tr>
<tr>
<td>8</td>
<td>F</td>
<td>21</td>
<td>Viola</td>
<td>6-10</td>
<td>3</td>
</tr>
<tr>
<td>9</td>
<td>F</td>
<td>20</td>
<td>Trumpet</td>
<td>11-20</td>
<td>4</td>
</tr>
<tr>
<td>10</td>
<td>M</td>
<td>23</td>
<td>Guitar</td>
<td>11-20</td>
<td>3</td>
</tr>
</tbody>
</table>

Participants also reported high levels of Variations use. All 10 claimed to use Variations at least 1-5 times a week, with two reporting use of Variations more than five times a week. Two reported that they began using Variations within the last year, but most had been using Variations for at least the last two years (four within the last two years; four more than two years ago).

Respondents’ typical Variations activities were also gauged. Answers were inclusive of the following activities:

- course reserve list listening for classes
- recital/performance/orchestra/lesson preparation
- homework/paper research
- personal listening

III. Method

All test sessions were coordinated by the facilitator and completed at the School of Library & Information Science (SLIS) Usability Lab. Upon each student’s arrival at the lab, the facilitator explained briefly the purpose of the usability test and also made sure that participants were comfortable with the set-up of the lab. Participants were then seated at a PC (set to 1024x768 resolution) and given a packet of information and briefed on the session procedure. First, each participant filled out a demographic questionnaire (see Appendix, p. 27). Once done with that, the facilitator entered the test room and explained the Scenarios section (see Appendix, p. 28) of the packet. The participant then logged into the Variations2 system and attempted to complete the given scenarios while thinking aloud. Audio as well as computer screen interactions were videotaped for future analysis. After the scenarios and tasks were completed to the best of the participant’s ability, the participant filled out a V2 satisfaction survey (see Appendix, p. 30). After the participant completed the survey, the facilitator then asked a few debriefing questions based upon observations of the participant’s scenario and task.
completion activities. Finally, the facilitator thanked the participant for his or her participation, answered any questions about the testing procedure that the participant might have had, and then had the participant fill out a receipt for the $15 Borders gift card each received for participation in the session.

**Pilot Test**
The first session was run as a pilot test in order to solidify the testing procedure and make any necessary adjustments. After the pilot, several changes were made to the wording of the Scenarios in order to simplify the task requirements and reading flow. The demographic questionnaire and satisfaction survey remained the same.

**IV. Findings**

Findings are organized by scenario. In cases where specific qualitative comments are presented, each comment is designated with a # in reference to the associated user, e.g., comments given by participant number 4 would be represented by “[#4]”.

**Scenario 1**

Searching
Two users had difficulty logging into Variations2 due to IU username and password synchronization issues. In both instances, the participant was instead logged in under the facilitator’s username. Once the participants entered Variations2, they were initially presented with the basic search window. None of the participants had notable difficulties entering search strings (e.g. “Schubert” and/or one of the song titles provided in the scenario) and retrieving results. Three users [#6, #8, #10] pressed the “Details” button once search results were presented, two in order to find the track time information and the third as a last resort to unsuccessful attempts to print. One participant performed a successful keyword search in addition to the Basic search. User #10 changed the Media Format dropdown selection to “All Recordings” while searching for the recording of Nachtviolinen for task 1. The same user then selected “Full Scores” to get to the score for Nachtviolinen for task 3.

One user associated the search process with that of **IUCAT**. For instance, user #9 entered the search term, “Der Junglish an der Quelle D300” into the Work Title field. When the search results came back empty, she immediately deleted the “D300” part. When asked about this behavior she responded, “it’s just a normal thing that numbers don’t work [in IUCAT].” Similarly, when asked what she entered for a different search query, she said, “...something that would work in IUCAT”.

Many cited enjoyment with the search process overall: “Cool that you can choose between Publisher” [#1]; “I like this – this seems a lot easier, a lot more user-friendly than the old Variations...This search engine seems to be a lot better than the new IUCAT they have.” [#2]; “I like that it starts out on the basic screen...with so many categories to enter information in – that’s very helpful....It was really easy to get to the recordings.” [#3]; “I love all of this information...pops up along with the piece.” [#4]; “...much easier to use than I thought it would be....Search screens are very easy to use.” [#5]; “The organization of a search was clear and easy to understand, making it easy to access what you needed” [#6]; “Thought it was good to be able to click on score/translation/recording” [#7]. User #9 liked how the search results offered

---

1 IUCAT is the Indiana University online, searchable library catalog system.
recordings, scores and translations all at once and that the “search was really easy, probably because I’m used to IUCAT. This was a lot simpler.”

In contrast, some comments and/or actions exemplified minor problematic issues such as the search being slow: “I like the back and forth feature in the...search window...a little bit slow.” [#2]; “Sometimes the computer gets caught up and the wait makes me feel like I did something wrong.” [#4]. In addition, pressing the Enter button did not function like the “Search” button [#2 issue], and the action of scrolling via the middle mouse button did not work. User #8 felt that the components by themselves were easy to use but became difficult when trying to integrate them: “I think it’s great, I just don’t find it to be...not very user friendly...having all the screens open and having to navigate the pages which don’t match. Lacks the ease with which I use Variations 2. I don’t doubt that two or three times after using it, I would be more accustomed.” Similarly, user #4 also felt that “The program is a little overwhelming to maneuver through at first, but when I went back for the second time around (!) things were much faster.” User #6 experienced some difficulty clicking on the exact link to open the player or viewer, often taking two mouse clicks to get it right. As well, this user never clicked on the Work title (e.g. Nachtviolen) to open the media player, but instead clicked on the second link in each result item link, either “From Score:” or “From Recording:” (see Figure 8).

Figure 8 – Search Results Link Lists

Media Player & Track Times
For tasks 1 and 2, users were asked to find song lengths via the media player interface. None had exceptional difficulty finding the track times once they opened the media player and examined the interface although track time indicators were not immediately obvious for some: “It’s hard to find the track length...oh there it is...nevermind.” [#1]. Similarly, #5 felt that the Track/Total radio buttons were not immediately obvious and that the time should default to the Track time rather than the Total time. User #2 in particular liked being able to have more than two player windows open at the same time, but suggested that it would be helpful if the timer was not linked to the view (Track/Total). In other words, this user wanted timing options such as “Track”, “Track Remaining”, “Total”, and “Total Remaining” viewable while the slider bar view remained static.

Score Viewer
Participant #5 liked being able to have both the score viewer and the media player open at the same time but also felt that some parts of the score were blurry, a complaint which was also prevalent in usability testing of the Variations2 prototype. User #7 enjoyed the zoom capabilities and different viewpoints available for examining a score. #4 liked the score access, citing that they are “easier to move around in than they have been on previous programs.”
Icons
Distinguishing recordings from scores and/or scores from translations via iconic representation presented difficulties for some users but was an easy task for others. One problem was that there was no explanation of which icon was which except in the text “From Score” or “From Recording” (see Figure 8). When completing Tasks 1 and 2, user #3 immediately scrolled through the search results list down to the recording, past the scores, and clicked the media player open. On the other hand, user #4 accidentally opened the score/translation viewer before the media player, and commented, “So it’s a little confusing to find where to play the music.”

The second problem was that some users had difficulty discerning whether an item was a translation or a score (during tasks 3 and 4) because those icons are identical. Thus, several users who were searching for a translation hesitated before selecting the proper search result. One possible error was that they clicked on a score item when searching for a translation, or vice versa. In the worst case, users clicked the recording icon which opened the media player. Those users then had to go back to the search results page, find, and then click the icon to open the score/translation viewer. User comments about these problem included: “Only way to tell difference between score and translation was that the score had three lines and translation had five [#2], as well as debriefing session comments that the most difficult part of using Variations2 was that is was “hard to decipher which was a translation and which was a score” [#4].

Figure 9 - Search Results

Export to Browser Command
Problems abounded for users trying to find the proper way to print: “Printing was hard! – unless most people are more skilled than I am at exporting.” [#4]. None of the users initially knew that “Export to Browser” was the correct command, although some proceeded with that option because of their prior knowledge about File menus [e.g., #6]. #1 went to the File menu immediately, claiming, “I don’t really know how to print...thought I’d go to File.” However, this user did not further select “Export to Browser”. Instead, the same user exited the score viewer and selected a different “score” (which turned out to be a translation), which then opened in the score viewer. It was at this point that the user accidentally clicked on “Export to Browser”, commenting, “Suddenly I’m looking at Schubert.” #2 also clicked on File → “Export to Browser” immediately, but did not realize that was how to print: “I don’t know how to print this – think I’ll hold off on that task....” Other users did not immediately go to the Export command. User #3 at first sat back and looked at the screen, exploring the interface, and then said, “I don’t think I can find where to print this score from. I think I must be missing something here.” At this point, #3 searched for and opened the online help page, quickly clicked the “Viewing & Printing Scores” option, read the directions, and successfully accomplished the “Export to Browser” transaction in the viewer window. One user who could not figure out how to print tried highlighting the parts of the score he wanted and printing via selection of an image. User #7 did eventually click File → “Export to Browser” after commenting, “I’m not seeing a print button. I might be missing it,” but then was confused about how to proceed: “What did I just do?”

Page Number Synchronization

Every user had a problem finding the correct page of the score they wanted to print when going from the score/translation viewer to the .djvu viewer. This was because there were often introductory pages in the score (e.g. instrumentation, table of contents) that were counted as page numbers in the .djvu viewer, and as a result, not aligned with the actual printed page number of the score/translation. This resulted in massive confusion as users attempted to find the particular score/translation/page they wanted to preview and print. One strategy users frequently employed was manipulation of the page selection drop-down menu, scrolling and/or clicking through hundreds, sometimes thousands, of pages in a given score or work volume. Comments indicative of frustration with this problem included:

- “Says p. 60 but when I put that in it’s not the right page...For some reason, the print pages never match up! I’m sure it’s my fault. Ok, forget it.” [#1]
- “It’s kinda hard to find the pages.” [#8]
- “I kind of don’t understand why the pages don’t line up.” [#9]

See Figure 10 for an illustration of a multi-volume score with a large number of pages exhibited in a drop-down menu. Some users tried to select a page number from the drop-down menu while others did not see this option and instead clicked on the back and forward arrows furiously in an attempt to get to the correct page. Participant #3 at first used the arrows to click back and forth, and then selected a page number from the drop-down. However, he never got to the correct page on the initial selection. Rather, he selected a random page number, then clicked backwards or forwards a few pages to see which song number he was on in the score, then adjusted the page number he selected in the drop-down accordingly. This method of narrowing down the page range eventually worked, as he was able to ultimately attempt to print the correct pages. Unfortunately, he selected the incorrect printer icon and so only blank pages printed, a problem addressed in the next section. User #9 also had similar problems, and was quite persistent in trying to find the correct page for the Nachtviolen text by repeatedly clicking the arrows to turn pages one at a time, attempting to hone in on piece #26 in
the score volume. She also attempted to find the correct area of the translation by using the table of contents in the score viewer as a guide to the translation contents in the .djvu viewer. Finally, user #10 also had troubles as he didn’t realize the resulting score was what he wanted to print after selecting “Export to browser” since the first page of the score was not the page that was open in the score viewer window he had just left.

Help Page Window
As described in the previous paragraph, user #3 used the online help page for assistance in figuring out how to print out a score, commenting during debriefing that, “I was very surprised that it was helpful...usually just a bunch of computer jargon”. This was the first instance of participant use of the help page, although an earlier user’s comments indicated that having to use the help menu might throw users off: “People might start to hyperventilate if they have to use the help menu” [#1].

Aside from the anchor link title “Viewing & Printing Scores” being slightly misleading due to the omission of the word ‘translation’, there was a major problem in this context. Once the online help page opened in a web browser window, users were presented with two windows: the help page browser window and the score viewer. After reading the directions on the help page, users then attempted the “Export to Browser” command found in the File menu of the score viewer window. Once the users did this successfully, the help page content was replaced with the exported score/translation since it, too, opened in a browser window (.djvu viewer). This rendered it impossible for the user to switch back and forth between the help page and the .djvu viewer in order to
successfully follow the further printing instructions. Participant #3 had to open the help page two times and then choose “Export to Browser” twice also before he understood how to select a page for printing; user #8 simply gave up on printing at that point and started a new search.

Participants who experienced this problem were lax in verbally expressing dissatisfaction with this flaw, but it was clear to the facilitator that there was much unnecessary browser window opening, switching, and scrolling involved in using the Help Page for printing.

Multiple Print Options
Only two users successfully printed a score or a translation [#2, #4]. Most printed out blank pages, not realizing that they were using the incorrect print icon inside the viewer window. As illustrated in Figure 10, there are 3 printing options available in the .djvu viewer. However, pressing the printer icon in the .djvu viewer program toolbar (No. 2) is the only method that actually results in a correctly printed page. The choice of either the File → Print option (No. 1) or the printer icon option on the web browser toolbar (No. 3) results in a blank page. User #2 discovered this problem when checking the Print Preview, which displayed a blank page. At this point, #2 tried to enter some page ranges in the browser print option box, but was unsuccessful. Finally, #2 saw the printer icon in the .djvu viewer toolbar, but expressed reservations: “I’m afraid to press it – scared that 1,000 pp. will print. So, I won’t do that just out of fear.” Eventually, this user did attempt to print using the correct printer icon, but was unsure whether he printed successfully: “So, I attempted to print them, but I’m not sure if they did or not.” As well, participant #3 expressed similar uncertainty about printing correctly with regard to both scores (“That was hard for me to find…do. I don’t know about some of your savvy undergrads….”) and translations (“I hope I did that right.”). The same user claimed in the debriefing session that score printing wouldn’t be anything he would use, but instead that he would “just go to the stacks and copy it”. Other comments echoing the sentiment that printing was hard came from participant #6, who also printed from the browser File menu: “It was difficult to print things from the page such as scores or translations.” and user #7: “I’m not seeing a print button. I might be missing it.” Finally, user #9 felt that printing straight from Variations2 windows would be easier while #1 just gave up trying to ensure he was printing correctly: “I’m going to print this wrong thing also.”

Miscellaneous Printing Problems
Due to the nature of the .djvu viewer, it would have been possible for a user to accidentally printing an entire score. User #2 recognized this problem, and that it “would be horrible if someone accidentally said ‘Print All’.” Currently, users must take caution to ensure that the correct page range is selected in the print dialog options box.

In addition, user #8 had difficulty with the help page when she tried to figure out the instructions for printing a score/translation. This was due to the fact that the help page figure did not have the correct printing icon marked on the illustrative graphic.
Users resorted to other methods to retain the particular pages they wanted to print. One method attempted was to choose to Save (designated by disk icon), thereby downloading and saving the translation pages for further exploration. User #8 attempted to do this and received the “Saving…” dialog box presented in Figure 11. If one chooses the “Bundled” option, then a single index file is saved to the chosen destination. On the other hand, if one chooses the “Indirect” option, a single page is saved to the destination for every page of the score or translation! As shown in Figure 12, this option resulted in hundreds of files being saved to the Desktop. The user was unsurprisingly overwhelmed by this occurrence, and the facilitator had to intervene in order to delete all the extraneous files from the computer Desktop. This user was obviously quite frustrated, commenting, “Oh god, this is so difficult. I don’t like this program at all – it’s too complicated…I don’t know what to do. This is crazy.”
Initially, this task scared participants! The requirement to create a webpage was deemed difficult immediately, and the facilitator had to intervene several times in an attempt to assuage feelings of discomfort. Comments included: “Oh my god, this sounds hard! I hope I don’t have to do this.” [#1]. Similarly, user #2 opened first the player and then the score viewer and immediately made several resizing attempts, including window resizing, zooming, and switching to Compact View, and then commented, “...trying to figure out where to go to figure out how I create a web page.” Curiously, this user was also observed double-clicking on various words on the assignment Webpage, though none of those words were links.

Help Page
Once participants were guided to the Help page, this usually aided them in successfully creating their .html pages. In two cases, going to the Help page assisted users with completion of Scenario 1 after starting Scenario 2. In addition, user #3 successfully completed Scenario 2 in the fastest time after viewing the Help Page. Although user #4 was silent throughout most of the Scenario 2 tasks, she did use the help link and eventually completed the assignment, commenting that the “help page was extremely useful.” #5 also used the Help page and had high compliments: “The help file is incredibly useful and very clearly written....”
**Bookmarking**

Some of the bookmarking issues users encountered were holdovers from the prototype version of Variations2; still others were new problems. One leftover problem was the difficulties that occurred as some users tried to select a certain spot for bookmarking. User #8, for instance, did not see the Track/Total time radio button selector, and so attempted to get to the right place in the piece by adjusting the slider bar in minute amounts. An additional issue that lingered from the prototype was the fact that clicking a bookmark on the slider did not necessarily move the player to that exact point. User #1 experienced this, commenting, “When I click on the bookmark, it goes someplace else. That might be confusing.” During debriefing, users expressed that the “bookmark feature was hard to figure out originally, but great once I figured it out.” [#4].

Users were fairly exploratory with bookmarking features. For example, they frequently checked the dropdown lists from the bookmark Menu to see if a bookmark had been added, deleted bookmark files, and cleared all the bookmarks with the “Clear” button. Users became frustrated if they could not find a comment they thought had just been added: “I don’t know why my stupid comment wasn’t saved.” [#1]. In this case, the reason the comment was unseen was because the comment list item was not expanded. Other problems occurred with users not seeing the bookmark and/or annotation they had just created. In some instances this was due to the fact that the bookmark hierarchical menus do not automatically expand when the bookmark edit window is opened. In other cases, the problem was due to the fact that the bookmark edit window does not automatically open with the last bookmark created highlighted. Another reason was that the track title was so long, the comment to the right was obscured from view due to the fixed default window width. Another user clicked the “Import” button rather than “Update” and so the comment was not added. Yet another user added bookmarks, but did not add any comments to them [#2]. One user commented that the “Delete” warning message should be different for just one bookmark as opposed to the “Clear All” option.

**Synchronization**

Another frequent difficulty occurred because recording playback and score movement were not synchronized. This caused several users to place both the media player and the score viewer open side-by-side so that comparisons could be made (see Figure 14). In one attempt to deal with this problem while bookmarking for the assignment, user #8 at first manipulated the player by moving the slider back to the beginning of the track and then moved the player so she could see the score. When the recording got to the point she wanted, she placed a bookmark in the recording, then immediately placed one in the score in order to get them to line up. At least three users suggested that synching the score with the recording would be helpful [#1, #7, #8]. User #1 commented that it “would be cool to get the two synchronized, then you could bookmark both at the same time.” #1 also felt it was easier to make bookmarks and comments on the recording as opposed to the score viewer, presumably because the recording enabled him to listen as he placed the bookmarks: “Do the music and the score have the same bookmark system? I don't know what's going on.” [#1]. User #5 took a different tactic toward dealing with the commenting portion of the task by writing down information about the instrumentation from the score and then placing bookmarks with comments in the recording which reflected those written notes.
Exporting

Most of the problems with exporting bookmarks into an .html page were conceptual. For instance, users #8 and #10 attempted to export every bookmark individually, not realizing that all bookmarks made would be exported into a single .html page. User #2 had to use the Help page to figure out how to export bookmarks. Once he clicked “Export” the resulting .html page was received well: “Ah, cool. Oh, that’s really convenient how it automatically creates all the links...so I guess I just do the bookmarks and it will automatically create the web page for me.” After exporting, he also commented that it would be nice if the .html page results were ordered so that [future] synchronized recording and score bookmarks appeared one after the other as a pair.
Once participants had created their bookmarks, and figured out that they should choose the “Export” button, the Save window appeared (Figure 16). In this window, users chose the destination for the .html bookmark file. At this point, there were problems as users became lost in the hierarchical file structure. When they attempted to reopen the .html page to see the results, they often could not find the file. At this point, the facilitator had to intervene with several participants. The facilitator pointed out where the file could be found, and then retreated to the observation room to see what participants did with the .html page (Figure 17). Once the page was retrieved, participants were enthusiastic about the results: “So granted the person knows what’s going on, this could be really good….Could be good for studying.” [#1]
Satisfaction Ratings
Participants were asked to fill out an 11-question Satisfaction Survey after completing their tasks (see Appendix, p. 30). For each question, users could rate their experience with the system by circling a number on a 1-7 continuum. Question topics ranged from general system satisfaction to inquiries about specific Variations2 components and
processes such as navigation and window management. Negative adjectives were placed at the low end of the continuum (1) while positive adjectives were placed at the high end (7). Thus, a lower mean score for a particular question indicates a lower satisfaction rating. Consolidated results of the satisfaction ratings are presented in Table 2. Each response is marked with a “♦” in its corresponding rating score column. Mean, or average, scores as well as median (most frequent rating) scores are also shown.

Overall, participants expressed average to high satisfaction with Variations2. The element which received the highest mean score was the appearance of characters (mean=6.5), followed by the knowledge of location ranking (mean=5.8). The lowest score was given in the Frustrating <---> Satisfying continuum (mean=4.1) followed by the navigation component (mean=4.3). Participant scores indicate that they felt that the system was above average in the Terrible <---> Wonderful continuum. However, this rating was countered by several below-average low ratings on the Frustrating <---> Satisfying continuum. Most felt that the number of windows open were easy to manage, although one participant did give this component a 1, or “Difficult to Deal With”, rating.

Table 2: Satisfaction Survey Results for Variations2 v1.0

<table>
<thead>
<tr>
<th>Question</th>
<th>Ratings</th>
<th>Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Overall, I found Variations2:</td>
<td>Terrible</td>
<td>Wonderful</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------</td>
<td>---------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Difficult</td>
<td>Easy</td>
<td></td>
</tr>
<tr>
<td>Frustrating</td>
<td>Satisfying</td>
<td></td>
</tr>
<tr>
<td>Dull</td>
<td>Stimulating</td>
<td></td>
</tr>
<tr>
<td>Slow</td>
<td>Fast</td>
<td></td>
</tr>
</tbody>
</table>

2 This score was actually a 5.5. The participant circled both 5 and 6 so the average was taken.
<table>
<thead>
<tr>
<th>Question</th>
<th>Difficult</th>
<th>Easy</th>
<th>Rating 1</th>
<th>Rating 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>2. Navigating Variations2 and its components was:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3. Tasks could be performed in a straight-forward manner:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4. My location within Variations2 at any given moment was:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5. Characters (letters, type, fonts) in Variations2 are:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6. Organization of information in Variations2 is:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2/3/2003 V2 Usability Test v1.0 Report
V. Recommendations

Recommended Variations2 design changes are listed in Table 5 and organized by system components. Each recommendation is assigned a severity rating that should determine the priority given to fixing the issue. Severity ratings are as follows:

**High** – Issue prevents users from making progress or led to severe mistakes.

**Medium** – Issue causes confusion, inefficiency, or minor mistakes.

**Low** – Issue causes slight amounts of confusion or dissatisfaction.

**Bug** – System was not functioning properly or was an external issue.

Table 5 – Issues, Recommendations, and Severity Ratings

<table>
<thead>
<tr>
<th>Issue</th>
<th>Recommendations(s)</th>
<th>Severity Rating</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Searching</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Initial log in to Variations2 did not work.</td>
<td>• IU Network ID and password need to be synched before attempting to log in to Variations2.</td>
<td>Bug</td>
</tr>
<tr>
<td>“Details” button rarely used.</td>
<td>• Place Details button closer to results information.</td>
<td>Low</td>
</tr>
<tr>
<td>Search is slow, especially when using the &quot;Back&quot; and &quot;Forward&quot; buttons.</td>
<td>• Increase speed. • Add a drop-down feature to the Back button in the search window (similar to a web browser).</td>
<td>Medium</td>
</tr>
<tr>
<td>Scrolling through results lists with mouse not functional.</td>
<td>• Program this functionality into next version of software.</td>
<td>Low</td>
</tr>
<tr>
<td>Difficult to click exactly on the links in the results lists.</td>
<td>• Spread the links out more vertically.</td>
<td>Low</td>
</tr>
<tr>
<td>Hard to distinguish between a score and a translation in the results list.</td>
<td>• Design a distinct icon for translations/texts.</td>
<td>High</td>
</tr>
<tr>
<td>Users click on links that are supposed to open player/viewer windows several times before it appears to be doing something.</td>
<td>• Have activated link change color to indicate that it has been clicked.</td>
<td>Medium</td>
</tr>
<tr>
<td>Media Player and Score Viewer windows are slow to load and open.</td>
<td>• Once the link is clicked, switch immediately to the Media Player or Score Viewer window to indicate some loading progress.</td>
<td>Medium</td>
</tr>
<tr>
<td>Pressing “Enter” on the keyboard to initiate a search does not work. Rather, one must click on the “Search” button.</td>
<td>• Add functionality that allows the action of pressing “Enter” on the keyboard to automatically start a search.</td>
<td>Medium</td>
</tr>
<tr>
<td><strong>Media Player</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>In the Total view, track arrow indicators are overwhelming rather than helpful when there are many tracks.</td>
<td>• Instead of arrows, indicate tracks with a line (</td>
<td>) or a number.</td>
</tr>
<tr>
<td>Issue</td>
<td>Recommended Solution</td>
<td>Severity</td>
</tr>
<tr>
<td>-------</td>
<td>----------------------</td>
<td>----------</td>
</tr>
</tbody>
</table>
| Users do not associate the Track/Total buttons with the changes in the slider bar. | • Enclose track timing buttons in same partitioned area as the moving slider.  
• Place start time on left side of slider and end time on right side. | High |
| **Score/Translation Viewer** | | |
| The scores appear blurry in the score viewer window. | • Adjust resolution  
• Allow users to be able to adjust resolution. | Low |
| “Export to Browser” command is not intuitive as the path to follow to print a score/translation. | • Change wording to “Print…”  
• Incorporate a Printer icon button in the score viewer window interface. | High |
| Users become “lost” in the score/translation in the .djvu viewer | • Have an overview of the score such as bookmarks or thumbnails in the .djvu viewer, similar to score viewer “Form” tab.  
• Indicate volume numbers in the drop-down page number list.  
• Try a different viewer! | High |
| Users have to backtrack to the search results window to open a score or recording. | • Indicate on the media player if there is a score available for the piece being played as well as a link to it.  
• Include player controls in the score viewer. | Medium |
| **Printing** | | |
| The .djvu viewer opens in a browser window, replacing any current browser window content, e.g. the Help page. | • Have .djvu viewer open in a new browser window. | High |
| There are multiple methods for printing in the .djvu viewer window. | • Add detailed instructions to the help page and an illustrative graphic.  
• Disable the incorrect print options. | High |
| Difficult to navigate to the desired page. | • Include ability to jump to different sections or volumes in addition to single page turning or page selection.  
• Have .djvu viewer window open to the page which was open in the score/translation viewer. | High |
| **Bookmarking/Exporting** | | |
| Contents of the deletion dialog box messages are confusing. | • Have a different “Delete” message for a single bookmark deletion as opposed to “Clear All”. | Low |
| Users either manipulated windows so that the score viewer and media player were side by side for bookmarking purposes or they constantly switched back and forth from player to score viewer window. | • Add a "Sync/Un-sync" button option which will “join” together the media player and score viewer so that bookmarks may be made simultaneously.  
• Have the default position of score viewer on right side of the screen and the media player on the left. | Medium |
| “Update” button on the bookmarks editing window was confused with the “Import” button. | • Change the wording of “Update” to “Add” and move it closer to the comment. Or, delineate it from the movement arrows? | Low |
| Users had to switch between the media player and score viewer frequently when attempting to add bookmarks. | • Have the media player indicate that there’s a score available for the piece being played, plus a link to it.  
• Include player controls in the score viewer. | Medium |
| The word “Export” is unintuitive for creating a web page. | • Change the “Export…” button text to “Create Webpage…” or “Save to Webpage” | High |
| Saved .html page is hard to find in the file hierarchy of the computer. | • When users Export, have the .html page open dynamically, and then have users save.  
• Create a default “Bookmarks” folder when a user chooses “Export…” | High |
| On exported .html page, there are no headings which distinguish recording vs. score bookmarks. | • Pair recording/score bookmarks on .html page (if they are synchronized).  
• Add “Recording Bookmarks” and “Score/Translation Bookmarks” headings to .html template. | Low |
| Moving the slider bar to a bookmark does not make the player start at that exact point. | • Line up the arrows or remove them. | Medium |
| It is not obvious where the comments are located on the exported .html page. | • Place a “Comments:" label next to each comment line. | Low |
| Due to the bookmark editing window default size, it was difficult to see a comment for a bookmark with a long track length. | • Have a marker to the left of the bookmark if there is a comment.  
• Have comment appear underneath track title.  
• Have last bookmark added highlighted when Edit Bookmarks window is opened.  
• Have bookmarks | High |
Help Page

<table>
<thead>
<tr>
<th>Recommendation</th>
<th>Priority</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatically expand if there is a comment.</td>
<td></td>
</tr>
<tr>
<td>• Indicate with an arrow that a comment is present if it runs off the right side of the screen.</td>
<td></td>
</tr>
<tr>
<td>• Add “Expand All” or “Collapse All” buttons in bookmark edit window.</td>
<td></td>
</tr>
<tr>
<td>Users seem to miss the “Export...” button in the bookmarking window illustration in the Help page</td>
<td>High</td>
</tr>
<tr>
<td>• Change the color of the box around the Export button from yellow to green.</td>
<td></td>
</tr>
<tr>
<td>Users attempted to export each bookmark individually rather than all at once.</td>
<td>Low</td>
</tr>
<tr>
<td>• Add instructions to help page for this problem.</td>
<td></td>
</tr>
<tr>
<td>Help page illustration of “printing” unhelpful because the correct print icon was not distinguished from the others.</td>
<td>High</td>
</tr>
<tr>
<td>• Change the help page illustrative graphic to one in which the correct print icon stands out via, e.g., a colored circle and appropriate text label.</td>
<td></td>
</tr>
<tr>
<td>Printing is an activity that is inherently separate from viewing and involves a separate set of instructions.</td>
<td>Medium</td>
</tr>
<tr>
<td>• Have a separate help page section for “Printing”, i.e. divide up the section entitled “Viewing &amp; Printing Scores”</td>
<td></td>
</tr>
<tr>
<td>It is possible to download hundreds of files to the computer Desktop in the .djvu viewer.</td>
<td>Low</td>
</tr>
<tr>
<td>• Include instructions for NOT doing this in the help page.</td>
<td></td>
</tr>
</tbody>
</table>

VI. Future Testing

The following list of recommendations would likely improve the process for future testing procedures:

1. For future usability tests which require participants to print documents, it is recommended that the printer be located in the same room as the participant. In this test, participants were unable to check what they had printed and so most went on with the Scenario 1 task without confirmation that they had successfully printed a score or translation.

2. Future tasks which require creation of a webpage for an “assignment” would likely be better completed as part of an assignment in a real context (e.g. the Variations2 Pilot Studies conducted by Mark Notess). Some instruction prior to attempts to complete a webpage assignment would help students initially.

3. A future test situation that might elicit different and interesting behaviors is one in which students complete their sessions in pairs. This would be more similar to a frequently observed Variations use context in the music library, in which students gather in pairs or groups to do their listening homework with Variations at a single computer in the lab.

4. Future tests should incorporate no more than 5-7 actual users (exclusive of the “Pilot” user). By the time users 8-10 completed their sessions, many of the issues with the software had been discerned and so the last few user sessions provided
less return as well as more repeat data which then had to be analyzed. Usability tests with fewer users would probably be more cost-effective in the long-term testing scheme for Variations2 versions.

5. It may also be helpful to have a second facilitator present during test sessions for note-taking purposes.
VII. Appendices

I. Demographic Information

1. Are you Male / Female? (Circle one)
2. What is your major? (e.g. composition, voice, piano):

3. What is your age? ______
4. What is your native language? ______________________
5. How many hours per week do you spend using a computer?
   [ ____ 0-5]  [ ____ 6-10]  [ ____ 11-20]  [ ____ 21 or more]

6. Rate your computer experience on the following systems by circling 1-5 below:
   a. PC: Novice 1 2 3 4 5 Expert
   b. Macintosh: Novice 1 2 3 4 5 Expert

7. Approximately how often do you use Variations?
   _____ once a month or less
   _____ once every two weeks
   _____ once a week
   _____ 1-5 times a week
   _____ more than 5 times a week

8. When did you begin using Variations? Mark the most accurate choice.
   _____ within the last month
   _____ within the last year
   _____ within the last two years
   _____ more than two years ago

9. What activities do you mainly use Variations for? (e.g. listening to a class reserve list, preparing for recital, personal listening, etc.)

11. Have you participated in any prior Variations2 tests? (circle one) YES  NO
II. Scenarios

You will be asked to complete two scenarios using Variations2. Please read through each scenario before attempting to answer the questions or complete the tasks associated with the scenario.

Scenario 1

You have decided that the first part of your senior voice recital will have a Schubert theme. To prepare, your voice teacher suggested that you listen to several different Schubert songs and pick the ones you like. Using Variations2, you have already found 2 pieces you definitely want to include:

- “Nachtviolen”
- “Heimliches Lieben, D.922”

For your third piece you’re torn between the following three choices:

1. “Fischerweise, D. 881b (von Schechta)”
2. “Der Jüngling an der Quelle D300”
3. “Frühlingsglaube D686 (Uhland)”

Use Variations2 to complete the tasks below as you search for information about the Schubert pieces that will be included in your recital.

To Begin: Open Variations2 by selecting Start → Programs → Variations2 on the lower left side of the computer screen.

Tasks:

1. Record below the lengths in mm:ss (minutes:seconds) of pieces 1. and 2.
   
   “Nachtviolen” length:
   “Heimliches Lieben, D. 922” length:

2. Pick a third piece from the list above so that this part of your recital will be no more than 10:00 minutes in length. Circle the letter of the song you picked below:

   a. “Fischerweise, D. 881b (von Schechta)”
   b. “Der Jüngling an der Quelle D300”
   c. “Frühlingsglaube D686 (Uhland)”

   What is the length of your third song? __________

3. Print the score for “Nachtviolen”.

4. Print the translation/text for the third song you picked.
Scenario 2

You are using Variations2 to work on an assignment for your music history class. The assignment requires that you give a short presentation about different instrumentation found in movement IV of Beethoven’s 9th symphony. To make access to Variations2 easier, your professor has put the assignment on the web.

To Begin: Open a browser window and enter the following URL:

http://ella.slis.indiana.edu/~mbswan/DML/v2scenario2.html
III. Satisfaction Survey
For each question below, circle a number from 1-7. The number should best represent your feelings about the Variations2 experience that you described in Section II. Feel free to write additional comments in the space provided below.

1. **Overall, I found Variations2:**
   - Terrible 1 2 3 4 5 6 7
   - Difficult 1 2 3 4 5 6 7
   - Frustrating 1 2 3 4 5 6 7
   - Dull 1 2 3 4 5 6 7
   - Slow 1 2 3 4 5 6 7
   - Wonderful
   - Easy
   - Satisfying
   - Stimulating
   - Fast

2. **Navigating Variations2 and its components was:**
   - Difficult 1 2 3 4 5 6 7
   - Easy

3. **Tasks could be performed in a straight-forward manner:**
   - Never 1 2 3 4 5 6 7
   - Always

4. **My location within Variations2 at any given moment was:**
   - Never apparent 1 2 3 4 5 6 7
   - Always apparent

5. **Characters (letters, type, fonts) in Variations2 are:**
   - Hard to read 1 2 3 4 5 6 7
   - Easy to read

6. **Organization of information in Variations2 is:**
   - Confusing 1 2 3 4 5 6 7
   - Clear

7. **The number of screens and/or windows open at any one time in Variations2 is:**
   - Difficult to deal with 1 2 3 4 5 6 7
   - Easy to manage

Additional Comments (use back of page if you need more space):
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________